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About TVrename

The App really brings out the best in your TV Wall quickly and easily.

It scans your series folder(s) and creates Mede8er compatible files required for your TV Wall.

The app also points out missing episodes and what’s just released thereby ensuring your library can be
kept up to date. This program has grown into a one click solution for Mede8er’s TV Wall.

Files created by TVrename for Mede8er:
Seriesinfo  (.xml file)

Episode Info (.xml file)

Fanart.jpg

Folder.jpg  (Show image)

Folder.jpg  (Season specific image)

Episode thumbs or Series.jpg

View.xml (displaying episode thumbs correctly)

File Options Touls Help
Wi Wy Sows | O, Sean | 25 Whento watch

lomation | mages

tvrename.com

berename.com - S04E06 - Quickstart Guide (v2.2)

Quickstart Guide
Welcome to TVRename!

This 1= a quick guide to help get you going. This page can always be accessed
by going to the Help menu, and choosing "Quickstart Guide™.

Here are the basic steps you need to do:

(1) Go to Toslz:Folder Manitar. This will let you add a lot of folders quickly,
and semi-automatically, After setting where the base of your media library is,
el it vo "Check®, then do a "Auto 1D A", TVRename will scan your media
library, and match up show names against TheTVDE, and alsa quess if you
have a "flat” structure with all your seasons in one folder, or separated out.
When finished, click "Add & Close” to add all identified folders to "My Shows".
You can manually add shows one-hby-one (even if they don’t have a folder on
disk somewhere) by clicking the "Add” button at the bottom of the "My
Shows” tab. Enter the show name, and click search to find its I code. Enter
the hase falder for the show in your media library, and select whether or not
you have a sub-folder for each season.

(2) Go to the "My Shows” tab and browse the series and episode information
far your shows. You can edit the show itself to contral how TVRename
manages that particular show, or edit a season to override the episode
information fetched from TheTVDE.

{3} In Options-Preferences, go to "Search Folders” and set where you
download new eplsodes to. Also visit Options>Filename Template Editor to
set how TVRename will rename your files.

{4) Go to the "Scan” tab, and click “Scan™. TVRename will download any show
information needed from TheTVDEB, and check your media library. You can
control what actions will be performed by clicking "Options..." before doing a
scan.

{9) After a scan, review the suggested changes and other information. Any

= Add A ER W Deete 30 2] Refresh L Open W Vst VDB
et anng: —

Startup screen when opened for the first time.

Getting started:

Download the setup file and install.

Start the program.......cccceceeecuennne

First you need to do some settings.

Delete mede8er.db file in your TV Series directory, the Mede8er TV Wall does not get Scanned..EVER!



Preferences:

Setting up Preferences: (Ctrl + P)....just a few things to set here (This only needs to be done once)

File | Options | Teocls Help

ij My Offline Operation
Lﬁg Autormatic Background Download

'nforrnation | Images |
|@ Preferences Ctrl+P ‘I
lgnore List Ctrl+I

@ Filename Template Editor  Ctrl+T
ﬁ Search Engines

Filename Proceszors

From the File menu > select Options > Preferences

Choose Mede8er as the default preset.

| General I Files and Folders | Automatic Export I Scan Options | Folder Deleting |
Media Center | Search Folders | pToment / NZB | Tree Coloring |

XBMC () Frodo () Eden (@ Both
[] Episode Thumbnails {tbn)

[] WNFO files for shows and episodes

[ Download ¥MBEC Images fanart. poster, banner jpa)
pyTiva

[] Meta files for episodes (bd)

[] Place Meta files in meta subfolder

Mede8er
[] Create series poster (series jpa)
XML files for shows and episodes
Shrink; large series and episode images

General
Felder image folderipa)
() Banmer () Poster () Fan At (@ Season Poster
Fanart Image fanart jpg)
Episode Thumbnails (jpag)

Media Center tab

.

in At (® Season Pod YEMC

pyTivo

MedeBer

Mone

| 0K || Cancdl |

Click ‘Presets..” & select Mede8er




Preferences — continued 1:

Please note: The Mede8er presets has been updated to default to Episode Thumbnails.
In this mode TVrename auto creates a file ‘View.xml’ in every Season folder to display the thumbs
correctly.

2 Broke Girls - SOTEOT - Pilot.avi

2 Broke Girls - SO1E01 - Pilot 2 Broke Girls - S

L =[N
caught'oy 2 [ Jennifer ©

araline to bie her roommate, but their new Vet

Example of Episode Thumbs — when selecting Episode Thumbnails (.jpg)

Should you wish to create ‘Series.jpg’ files:
Select ‘Create series poster (series.jpg)’  (check box ON)
Deselect ‘Episode Thumbnails (.jpg)’ (check box OFF)

Z Broke Girls - SOTEOQT - Pilot.avi

2 Broie Girls... 2 Broke Girls...

Jennifer

tment schieme. Max invit roline to be her. rcommate, but their new Matt

Example of Series poster — when selecting ‘Create series poster (series.jpg)’



Preferences — continued 2:

Media Center | Search Folders | uToment / NZB | Tree Coloring |
General | Files and Folders | Automatic Export | Scan Options | Folder Deleting |

Filename Replacements

- #

;ooood

Video extensions: |.avi;.mpg;.mpeg;.mk\r;.mpd;.wrn\r;.divx;.ogm;.qt;.rrn |

Other extensions: |.srt;.nfo;.t:t;.tbn |

Copy/Mave files with same base name as videa
[] Rename bt to sub
] Leading 0 on Season numbers

Specials folder name: | Specials

lgnore "sample” videos, up to IEI ME in size

[ Make all filenames lower case

=3
4]
>

OK || Cancel

Files and Folders tab

Assigning a color to a Show status

General | Files and Folders | Automatic Export | Scan Options | Folder Deleting |
Media Center | Search Folders | uToment / NZB | Tree Coloring

Add required video extensions that you
may have in the ‘Video Extensions’ box.

You may choose ‘Leading 0 on Season
numbers’

i.e.: Season 01 instead of Season 1

File  Options  Teools  Help
ﬁ My Shows |Q Scan | | Whmtcwam|

- jRob! P
- 2 Broke Girs

- 30 Rock

- 666 Park Avenue

- A Gifted Man

- Accidentally On Purpose
- Alcatraz

- Alphas

- American Homor Stony

- An Idiot Abroad

- Anger Management

- Are You There, Chelzea?
- Amested Development

Show Status Calor
Show Status: Ended HODDDAD \
Remove
Status: | v|
Text Color: | || Select Color | | A
| oK | Cancel

Tree Coloring tab

A color can be assigned to a Show Status.
Here’s an example of Shows that ended

Select ‘Show Status Ended’ from the Status

pull down menu.

Click ‘Select Color’ and choose one.
Click ‘OK’ and click ‘Add’.




Preferences — continued 3:

Scan options:

Media Center | Search Folders | pToment / NZB | Tree Coloring |

"Scan" checks and actions:

Rename Check

Missing Check
Look in "Search Folders" for mising files

[] Copyfiles, dont move

[] Check pToment queus
[] Check SABnzbd queue
[] Search R55 for missing files

General | Files and Folders | Automatic Export | Scan Options | Folder Deleting

0K

Scan Options tab

Search Folders:

General | Files and Folders | Automatic Export | Scan Options | Folder Deleting |

Media Center | Search Folders | yToment / NZE | Tree Coloring |

Manitar folders for changes
Scan Type

® Ful O Recent () Quick
Search Folders

D:\Downloads
D:\Ripped

Search Folders tab

Select Rename Check to have your
media files renamed as per set rules.
(explained on page 7)

Select Missing Check to determine
which episodes are missing from your

library.

Select ‘Look in...." for downloaded
episodes to be processed and moved
to the correct folders.

If ‘Look in “Search Folders”..” is
activated in the Scan Options tab the
path to the folders gets set here.

Click ‘Add’ and browse for the Folders.
Multiple folders may be added.

TV rename will move or copy the files
to the correct Show. It will rename it
correctly and create the required
episode xml and thumbnail image.




Filename Template Editor:

Setting up your ‘Filename Template Editor’: (Ctrl + T)
This will control your naming conventions for your TV Series episodes.

File | Options | Tools Help

m Iy Offline Operation

Automatic Background Download

|H‘ !
28 @ Preferences Ctrl+P
- GBI Ignore List Ctrl+I

Filename Template Editor  Ctrl+T

Al a Search Engines
- Alg Filename Processors

B S-SR
=

It has naming templates from which to choose or you may set it to your personal preference.

MNaming template: {Shanama} - 5{Season:Z}E{

Presets: | L |

Tags: | W |

Sample and Test:

Example Season Episode "
30 Rock - SO1EDT - Pilot 1 1

30 Rock - SOMED2 - The Aftermath 1 2

30 Rock - S01EQ3 - Blind Date 1 3

30 Rock - S01ED - Jack the Writer 1 4

30 Rock - SOMEDS - Jack-Tor 1 b

30 Rock - S01EDE - Jack Meets Dennis 1 &

30 Rock: - S0TEDT - Tracy Does Conan 1 7

30 Rock - S01EQE - The Break Up 1 B

30 Rock - SO1EDS - The Baby Show 1 9

30 Rock - S01E10 - The Rural Juror 1 10

30 Rocle - S0TE11 - The Head and the Hair 1 11

30 Rock - S01E12 - Black Tie 1 12

30 Rock - SO1E13 - Up All Night 1 13

30 Rock - S01E14 - The 'C" Word 1 14 W

OK || Cancel

File Template Editor window



Preparing your TV Series directories and files for TVrename processing:

| 2 Broke Girls S2E01.mp4
= 2 Broke Girls S2E02.mp4
=| 2 Broke Girls S2E03.mp4
= 2 Broke Girls S2E04.mp4

=) 2 Broke Girls 52E05 mp4

=) 2 Broke Girls S2E06 mp4
|2 Broke Girls S2E07 avi

)| 2 Broke Girls 52E08 mp4
7|2 Broke Girls 52E09.mp4

4 |5 TV Series

4 EZ Broke Girls

|5/Season 01
[E5Season 02

This will not be processed

You need to give it more info.
You can use a freeware Batch Rename utility
to fix this quickly.

Sometimes having the ‘Year’ in the filename
prevents the file from being
processed...remove the ‘Year’ if this happens.

This will be processed
It has sufficient information.

Rules for Show and Season folders:

2 Broke Girls
Season 01

2 Broke Girls SO1E01
2 Broke Girls SO1E02
2 Broke Girls SO1E03

Season 02
2 Broke Girls S02E01

2 Broke Girls S02E02
2 Broke Girls SO2E03

01 1
See ‘Leading 0 on Season numbers’ (page 5)

This is one of the BIG benefits of TVrename: the ability to throw all the episodes into its

respective folder and TVrename will create a synopsis and thumbnail image every episode.




Adding your Show paths in TVrename — Option 1
For large libraries.

Tools | Help

Force Refesh All
[#] Packground Download Mow  Ctrl+B

||_..3, Folder Monitor
[ Actors Grid

Torrent Match

uTorrent Save To

Tools menu > Folder Monitor

Folders | Ignore | Scan Results

These are the folders at the "top™ of your media library. Add one or mare folders here, either by dragaing and
dropping, or clicking "Add..." below. Go to the "Ignore” tab, or click "Check »>" when done.

Monitor Folders:

xMv series

Ad || Remove || Open | Check >

Folder Monitor window

Click ‘Add’ > browse for your Drive for your TV Series folder then click ok.
Selected Drive and Folder will show in the ‘Monitor Folders:” window. (Similar to above)
(If you have TV Series located on different drives/folders you may add them individually.)

Next step:
Click the ‘Check >>’ button.

(Please do a ‘Check >>’ every time you add a new Series to your collection...not required for new seasons.)



Adding your Show paths in TVrename (large libraries) - continued:

Checking folders

| Folders | ignore | Sean Resuts |

These are the: nerw folden that have been found. Tk "Auto 10 AT or manunaly edt sach to set the show. “ignom” to add the folder
Lo the kgriare st You can siso deag and drop folders inbo this kst. (Sek “Add A Close™ add al idertified shows to your "y Shows™ kst

‘Folder Monitor’ box appears and when this is
done a list of Shows will be displayed in the

‘Scan Result’ tab.

Nevw Shows
[Falder Shew Felder Struches thetvdb cods
'ty seas' The Smpsons The Smpsons Folder per season 71663
Select ‘Visit TVDB'’ to verify that it is the
correct show code.
| Auto I3 A Add 8 Close
Closs

Folder Monitor window - displays all the TV Shows found.

Select ‘Auto ID All’ - This will scan TheTVDB for relevant show codes. You may select ‘Visit TVDB’ to verify that it is

the correct show code.

Click ‘Edit’ if incorrect code found and type in show name to retrieve a list of shows, select the correct show and

H ‘ ’
click ‘ok
Folder Monitor - Edit Show = =
Search for The TVDB entry. by partial name or 1D:
TheTVDE code: |the simpsons | [ searcn |
Code Show Name Year
71663  The Simpsons 1989
[Found 1 show

x
Basics |Mva'1ced IShowNas&slSea’d‘l|
TheTWDE code: |common law | | Search |
Code  Show Name Year
253582 Common Law (2012) 2012
70838 Common Law 1956

Alternatively: under ‘My Shows’ tab,

Found 2 shows
Right click on desired series and select ‘Edit Show’

and rectify as required.

Please do a ‘Check >>" every time you add a new Series to your collection...not required for new seasons.
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Adding your Show paths in TVrename — Method 2
For small libraries.

Informaticn fetched from TheTVDE.

{3) In Options-Preferences, go ta "Search Falders” and set where you
download new episodes Lo, Also visit Options:Filename Template Editor to
set how TVRename will rename your files.

{4) Go to the "Scan” tab, and click "Scan”. TVRename will download any show
information needed from TheTVDEB, and check your media library. You can
contral what actions will be performed by clicking "Options..." before doing a

SCa.
(5) After a scan, review the sugpested changes and cther information. Any =
| A
Mt sing. —
My Shows tab

Select ‘Add’ at the bottom left

Basics | Advanced | Show Aliases | Search |

Basics | Advanced | Show Aliases | Search |

TheTVDE code: | || Search TheTVDE code: |2 Broke Girls ‘\\

Code  Show Name Year Code  Show Mame
Enter the show’s name, and click "Search” 248741 2 Broke Girs

Type in the name of the Show

[ | Found 1 show

[[] Custom show name: [[] Custom show name:

Airs in Timezone: | Eastem Standard Time ] | Airs in Timezone: | EageM Standard Time ] |

Ignore Seasons: | | eg."1 24" Dtoignore specials. lgnore Seasons: |1] \ | 2.4g."124" 0toignore specials. |
Automatic Folders Automatic Folders ) Browse for the
Base Falder | || Browse.. Base Folder | X:\TV Series\A\Broke Gits || Browse.. | folder
Folder per season, base name: Folder per season, base narge: °

[] Pad season numberto two digits %ﬂson number to two digits
\
ok || cancel |

N ook ||
|
Blank - Add/Edit show screen Edited - Add/Edit show scree \\

Cancel |

Select Pad if you

Type in the name of the show and click ‘Search’ - this will return the TVDB code.
Browse your hard drive for your Base folder (TV Show — NOT season)

Add in other info: ignore seasons, Pad season etc.
Click on the Show in the search box and click ‘OK’

want 01

File  Options Tools  Help
B My Shows |Q Scan | ] Whentowatch|

w Ilnfon'nation | Images |
pecials

i~ Season 1
i Season 2

Specials is greyed out as it was

added to ‘Ignore Seasons’ above (0)

2 Broke Girls

The newly created Show will appear in ‘My Shows’ tab

11



Scanning your Shows:

Select ‘Scan’ tab

Fle Options Took Help
M0 My Shows |, Scan | [ When to watch |
@ jRob! -

4+ 66 Park Averue

- AGited Man

- Accidentally On Pupose
- Moatraz

+- Amencan Horor Story 7.
i An Idiot Abroad - =3
- Anger Managemert.

G 2 Broke Girls

- Awake
5 Band of Brothess =
5 Beauty ard the Beast (2012) Overview

G Bert File Options Teools Help —

4+ Better Off Ted A comedy about two young women waitressing

Stk e Actors

n

{5 Common Law @012 9:00 PM Monday, CBS Show Seazon  Epizode Date Folder

& Grtum Information ' )
e o Seriesid 248741 Select scan method: ‘Full, Recent or Quick
4 Covent Affars FirstAired 2011-09-19

& Dead Like Me Year 2011

4 Dealer imdb.com Visit

4 Eemertary ContentRating  TV-14

4 Endgame Genre |Comedy|
B St NetworkiD

G Faty Legal Rating 8.1

¥, oo S RatingCount 46

. Frarkin & Bash Runtime 30

B Flinda tv.com Visit

4 Game of Thrones Status Continuing
i Gary Unmamed added 2011-05-14 07:37:19
L addedBy 235881

-

23 Options... |

=1 Add Aex | [Xooee |[% 18] | ElReiesh Z0pen | | vt VDS |

Net aing: The Vampre Dianes - SO4E03 - O Come. Al Ye Fathful. 0 7 (Fr. 03.00 AM)

My Shows tab
Select ‘Scan’ tab, this will open the Scan window with the following choices:

Full scan: Does a full check of all your Shows

Recent scan: Does a check of the last 7 days

Quick scan: Searches for any new files downloaded (looks in ‘Search Folders’ as specified in ‘Preferences’)
Options..: Quick link to ‘Scan options’ found in ‘Preferences’

Show: Rules of Engagement

Segson:  Tof 7
Folder: x:Mwv series'Rules of Engagement*Season 07
| lgnore Once | | lgnore Always | | Create | | Retry | | Cancel |

While Scanning it may prompt for ‘Missing Folder’ (this relates to missing Seasons)

Ignore Once: Ignores for this Scan and will prompt you again on the next Scan
Ignore Always: Ignores it for this Scan and ALL future Scans

Create: Creates the folder (recommended)

Retry: Do another check to find the folder (Season)

12



Scanning your Shows — continued 2:

File Options Tools  Help

M My S| L S | Whants wanch
| [Rsmn || Anecent | |21 optons.

Show Sewscn Epssts Date Fokdar Epaoda/Flename Foider Tiensma Fiename ~
Missing (19 mems)

[ 4, 2 ok Gls: 2 1] 2T wew serien'2 ok Geby'\Somsn 02 2 Broiee Gl - SOZE N - Ared the Big Opering.

[ & 2 Groke Gaa 2 n N2 v senea' Groks Gela' Semson 02 2 Groks Grla - S02E11 - Andithe Shent Pasrer

[7] 4 Amerizan Homor Ston 2 L] 20121213 wev series’ Amesicon Homor Story' Season 02 Amencan Homor Siory - SO0E08 - The Coat Hanger

O 4 Ao 1 E} FNPI2NF w'b serien' A Senson 011 Arrow - SOTEDS - Yoar's nd

15, Benes ] W 22NN v senes\Bones'\Season 0 Bones - SOOEN0- Episode 10

[ 4, Crmnal Minds ] n 20121293 x'ev series'Crminal Minds' Season 08 Crmingl Minds - S08E11 . Pemenisls

| & Dt ? n HNIIP w 't waries’ Deaber S 07 Dot - SOTE11 - D Yiow S What | S . . .

| ] 9, Dont Tustthe B—n Acasment 2 3 2M2A2 e senes’\Dont Taat the B— i Aoaiment 295e_  Dont Trust the B—in Spatment 21 SI2E0 - Bar Lies M'ss|ng ep|sodes
[ 4, Gossp Gl L L] 20129291 v senes’ Gossp el Seasen 06 Goss Gl - SDEEDY - The Revengens

], oy P 3 n HNPIFNT x v weciewHarwsi Frow O\ Simsson 03 i e ] - SUIE10+ Huska Moln

[, b | Mt Your Miother [ M FNZZTE v senes\How | Met Your Mother\Sesson 08 How | Mt Your Mther - SOEE10 - The hver Comection

| [ % Levernge 5 1 MII1212 w't series’ Leverage'Season 05 Lerenmge - SOSE13 - The Corloscrm Job

[ T3, Merin (2006} 5 ] NPT wv senes\Merin\Seamen 05 Merk (2008 - SU5E10 - The Kindness of Sirangens

[0 &, Modem Famiy 4 M ANZIBIT v senes\Modem Famdy'\Season 4 Madem Famdy - SOSE ] - Duamand in the ough

[T 44 piw G i n 21212 v menea’New GelSeason 02 Pierw Gt - SIZET1 - St

(153, Fucach b s 3 1 NPT x'tw wemes\ Rz B les’Seawor 03 Fszoh b s - SO3E13 - Vet Lave

| ] 54 The Mertalat 5 ] 20121210 x'¢v seoesThe Mertsiet'Sasecn 05 The Mertalat - SOSE10- Panams Fied

| ], The Mdda [ o ZNPIENI w'ev senesThe Micdie'Seasan (4 The Mdde - S4E10 - Twerey Yoo

| L 5, Whaney 2 4 BT ity enes Whitrey\Seascn 02 Whtney - S02E04 - Hello Grgghes:
Duversbisaed (3 Hari)

[# # 2 Broke Gels 'ty seres'\2 ke G posters/ 2LETALY, [— P o

W 8 200kt e e 2k e oo v Missing images
[ & Futes of Engagesent it neies'\Flies of Ergagement'Season 17 posten, 738421 pg Tokder oy
Medebes XML e (7599 Rems)

| [ W 2 Brokn G 1 1 HNLBA o« 't serien'd ok Gele'\Semsers 01 2 Breon Gela « SOTEDT - Plot sd

| [ il 2 Broke Gels 1 2 HND5ET e senes’2 roke Gl Semson 01 2 ke Gts - SO1E02 - A the Dreskasd Soaned

[ il 2 Broke Gela 1 3 2011004 v veriea’2 Brokie Gely' Sepson 01 2 Broiog Gary - SOVEDT - Ared Strokes of Goodwil el

[ ] 3 Broke Gle 1 4 FONIBAT  w't werien' 3 sk Gty Smacs 011 7 Fedom Gl « SOTEDM - e Som ich: P Frosblessss i

[ il 2 Broee Gela 1 5 NHIBIE  ev senen'2 Broke Gl Senson 01 2 Brosoe Gl - SOVEDS - Al the ‘S0 Horse Pay o

| ¥ il 2 Brmice Carla 1 & 11035 w'tv senes'2? Broke Gis'\Seavson 01 2 Breioe Girly - S0TEDS - Aret the Diappeanng Bed

[ i 2 Broke Gris 1 7 0M11901 w'tw emen'd ok Gr'\Season 01 2 Brokoe (Gl + SOVEDT - A she Fretty Probilem aml

ignzmm 1 ] M8 e senes’2 Broke G\ Semson 01 2 Broke ety - SO1ED8 - A Hoarder Cukture smi M > d

| [ il 2 Eroke Gla 1 3 NG w'ty semies''? ok G Sorson 01 2 Brokon Gl + SO1E09 - A e Fisnly Potty Catrad

| (41 1 2 Broke Gea 1 ] WNITEE ov sanea'2 firoke Gl Semson 01 2 Drokce Gl - SOVEND - A the Vary Cismas Tharkegrng s ISSIng metadata
[ il 2 Broke Gels 1 " 2NI206 x'tv senes’\2 Brokee Girla'\Semson 01 2 Broke Girla - SOTETY - A the Pealty Ohock el

[F] & 7 Brokn Gla 1 1w FINIIET  o'ew warien’ Brok Gk \Samacrs 01 ok Gk « SOVENZ - Ared e Pop-Lip Snbe

| [ ) 2 Broke Grla 1 1 020100 x'ev senes\2 Bk Grls'\Semson 01 2 Brokce Grla - SOIET] - Andithe Secret Ingredent ol

[ il 2 Brokn iy 1 u AT w'tw senea2 Brohn Gl Sesen 01 2 Brokee Gela - SDIE1E - A the Upstrrs Nesghbsor-amd

[ il 2 Broke Grls 1 15 HN2O2GT  wev wenes'2 Groke Grl'\Season 01  Broke Gels + SO1ENS A the Bnd Spctami

[#] il 2 Broke Gela 1 15 120214 witw veries’'2 Dok Gely'\ Season 01 2 Dok ety - SOTETE - Andithe Brokcen Hearts ol

| [# i 2 Broke Gl 1 ” FZARTT x'tw sies\2 frohe G Senmsons 01 2 ok Gila - SOVENT - A e Hober Cigpcoiues xond

[ W) 2 Broke Gas 1 w ANMBH x'ev senes'd Droks Gela' Senson 01 2 Groke Garla - SOTEVA - A the One-Night Stande sl =

| . P P PR — o "
P DoChecknd Qe Mrrcvs || | iromSel | | Ramove Sel Check: AM (] Reume [ CopyMove [1RSS [+ Downkoad [+ Madeber [ | iyTive

- SAEDS -0 Come. A Yo Farhd, 09 1 (e, 1300 M)

Click ‘Do Checked’, all checked items will be processed and created automatically

Please be patient while it’s
downloading image files, it might

| —% Done take a while depending on the size

of your library and internet speed.

| —% Done

| —GBfres

In TVrename options we have by
default set the Mede8er presets to

ttem £

Write XML
Write XML
Write XML

Write XML
Wiita WM
g

Bones - S03EDT - Boy in the Time Capsule xml
Bones - S03EDE - The Knight on the Grid xml
Bones - S03EDS - The Santa in the Slush xml

Bones - SO3E10 - The Man in the Mud xml
Ponae - SN3F11 - Plauar | ndar Prace: ira vl

‘Shrink large series and episode
images’ this optimizes the image
files by reducing them before adding
it to your library. This greatly
improves the speed of the
Mede8erTV Wall.
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Scanning your Shows — continued 3:

Fie Opions  Tock  Help
K My Shows| L e | Whento watch

Qe || Recet | |2 Options.
Srow Season  Episade (e

Mizsing (19 ltems)
L &% 2 Broke Grls 2 o Wz
] £ 2 Bk Gy 2 n FAFRFS Y]
[7] k. Amencan Heemer Sizey 2 L] 21213
L] S Ao ' 9 0121213
[ & Borms 8 w amzzn
(] 4 Crimsnal Minda 8 n 121213

| 5, Dester 7 n 0121210
] 5 Dont Tot the B—in Aparment.. 2 5 Wz
] %, Gt Gl B 5 anEn
[T] Ok Hawad Fve 0 1 1 mzzn
L] Hiow | Met Your Moher ] ] M0
] & Laversge 5 ] Az
], Merin (2008) L1 n 121208
[ ] 5 Modem Famiy 4 0 121213
[ % ew Gt 2 n Wz
] €4 Fareod & e a k1 FFRFRH
] & The Menigiet 5 1 20121210
] 5 The bhase 4 ] 20121213
] & Witirey 2 4 a1z

£
B DoChocked | @ Moo | 7| | bnorSel | | Resove Sel

Mest arrg. The Vampre Duses - S04E09 - O Come. Al Ye Fathful. 0d 6h (Fe. 03.00 AM)

Scan tab

Enider

&bw pevies'd Broke Gils'Season U2

&l ey B Gl S 02

v senes’Amescan Homer Ston Season 02
e senes’Amow' Season 01

&AL pevies’\Bores'\Season 08

v neries'\Crimunal Mindla' Season 02

Kt series'\ Diestar' Season 07

&Mv pevies'Don Trust $he B—in Aparimend Z3\5e...

&l merbeny sy Gl \Seamen O6
xv senes’Mawad Five 0'Season 03
v senes’How | Met Your Mother' Season 08
&Y pevies Laverage\Seasn (S
v seniea’Medn' Season 05

v senes\Modem Famidy'Season 04
&M pevies'Hew G\ Season U2

= Mt mertess Rk & ldea' Sseraem 13
kv senes' The Mentolat' Seasen 05
v senes'\The Mdde'Season (4
Kb wevies\Whirey Seascn 02

Eqinsae Henwma

2 Bk G - SUZETD - A the Big Coering

2 Beoiue Gl - SOZETT - Ard the Shord Pastnes
Amencan Hamor Story - S02E0% - The Coat Hanger
Ao - SOIEDS - Year's End

Bories - SOEET - Exiwode 10

Crminal M - SO8E11 - Prosorials

Dacer - SOTE 11 - Do You See What | See

Uit Trised the B—in Aostmert 23 - SUZEDS - Bar Lies
CGerais Gl - SOEE04 - The Hewergen

Harwoh Frve-0 - SUIETD - Huska! Kula

Haw | Met Your Mother - SOBE10 - The OverCosection
Leverage - SUSE13 - The Cokacrem Job

Meerin (008) - SOSESD - The Kincheas of Stmngem
Madem Famby - SO4E 10 - Diamond i the Rough

Mo Gt - SUZETT - Sarda

Pk & lades - SOAE13 - Wbl Lown

The Mertabst - SU5E10 - Panoma Red

The Mdde - SMEI - Twerty Yasrs

>

ek [ M [ Rename [ CopyiMove [ ASS [ Dowrioad [ Medeter [ pyToen

Once the Scan is completed your library should now contain all the Show and Episode synopsis including images.

Note:

Although TVrename will create the following files if not found it will not overwrite them if they do exist:

View.xml and Images files (fanart.jpg, series.jpg, folder.jpg and episode thumb.jpg’s).

We do not want to overwrite user preferred images that was saved and do not want to alter the View mode
users have set on the Mede8er.

Should you want TVrename to update the files they will need to be deleted (manually).

Series and Episode xml files will be updated as per the TVDB updates.
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Ignore files and how to restore Ignored files and folders:

After the Scan you will be left with episodes that are missing from your library.
You have 2 choices here: Update your library or ignore the missing episodes.

Show Season Episode Date Folder

kit : Ignore Selected
Taouch (2012) Z 2

Ignore Entire Season
Rename (1 ltem)

Remove Selected
(& The Vampire Diares 4 19 : v series\ The Vampire Diares'Season 04

Download (1 ltem) Search

To ignore the files: Right click and choose ‘Ignore Selected’

How to restore ignored files:
Go to ‘Options’ > ‘Ignore List’: (Ctrl + 1)

“\Blue Bloods'Season 03'Blue Bloods - S03E21 - Devil's Breath

Options | Tools  Help

Offline Operation

All the ignored files will be listed
in this window. Select the files
you want to remove and click
‘Remove’ and ‘OK’ to exit

Automatic Background Download

Preferences Ctrl+P

Ignore List Ctrl+|
@ Filename Template Editor ~ Ctrl+T

Search Engines

Filename Processors

An |diot Abroad

G

Edit Ignore List window

How to restore ignored folders (Seasons and Specials):
Under ‘My Shows’: Select Show - right click and Edit Show.

Basics | Advanced | Show Alisses | Search |
E—— TR =
File OQOptions Tools Help Code  Show Name Year

B0 My Shows | Q Scan | E Whento watch | 248741 2 Broke Gils

[ jRob! ~ || Inform:
Broke Girls

To restore any season:
Found T show Remove the number from here.

[ Custom show name:

Episode Guide
| Visit thetwdb.com
Force Refresh

Airs in Timezone: | Eastem #andard Time v |

Update Images

lgnore Seasons:
Automatic Folders

eg. "124" Dtoignore specials.
Scan "2 Broke Girls"

When to Watch

Base Folder ‘x:\tv serizs’2 Broke Girls ‘ | Browse... |

Edit Show Folder per season, base name:

Delete Show [[] Pad season number to two digits

Open: x\tv series\2 Broke Girls\5eason 01

Open: xhtv series\2 Broke Girls\Season 02 Cancel

L g

Add/Edit Show window
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2in 1 episodes

Episodes that are 2 in 1 will have 1 of them showing up missing.

To rectify this: Go to ‘My Shows’ tab.

3 Tools  Help
B My Shows Scan | 2] When to watch

- Cortinuum J ~

- Cougar Town
- Covett Affairs
- Criminal Minds
Dead Like Me
i Deatter

- Dont Trust the B—in Apartment 23
+1. Blementary

- Endgame

+]- Entourage

- Eureka - -
+]- Fairly Legal | Episode Guide

- Falling Skieg vyicit thetvdb.com

+1- FlashForwar
- Franklin & B| Force Refresh

Et-Friends
Special
Season
Seasan

‘Scan "Friends"
‘When to Watch
Edit Show
Delete Show

Edit Season 6

Expand the required Show folder

Right click on the season containing the ‘2 in 1’
Select ‘Edit Season ...

Show: Friends
() lgnore : Dont rename or check for episode(s)

(") Rename : Set episode name manualy
(") Remove : Remove episode(s) from the series
() Swap : Swap posttion of two episodes

Action Episode Episode Name

Click ‘Add’
#ad DI e | Dee | te [ Down

Friends - SOBED1 - The One After Vegas ~
Friends - SOBED2 - The One Where Ross Hugs Rachel

Friends - S06E03 - The One With Ross’ Denial

Friends - SOBED4 - The One Where Joey Loses His Insurance

Friends - SOBED5 - The One With Joey's Porsche

Friends - SOBED6 - The One On The Last Night

Friends - S06E07 - The One Where Phoebe Runs

Friends - S06E08 - The One With Ross’ Teeth

Friends - SOBEDS - The One Where Ross Got High

Friends - SOBE10 - The One With The Routine (3 k.a. The One With The Rockir
Friends - SOBE11 - The One With The Apothecary Table

Friends - S06E12 - The One With The Joke i

Optionally give it a new
name or leave blank for

(®) Merge : Merge episodes into multi-episode file Select ’Merge'
() Insert : Insert another episode into the season

() Split: Make one episode count as multiple

() Collapse: Merge episodes, and renumber

Input episodes to merge

New Name: |The one with the proposal|
{Leave blank for automatic naming)

automatic naming

Action Episode Episode Name

Do this for every ‘2 in 1’ episode as required.

‘The One With The Proposal

Tip: These episodes are normally double in size compared to the
others in the folder with usually twice the runtime.

b || Ew | osee [ tp || Douwn

Freview:

Friends - SO6EQ1 - The One After Vegas A~
Friends - SO6EQ2 - The One Where Ross Hugs Rachel

Friends - S06E03 - The One With Ross’ Denial

Friends - SOEEQ4 - The One Where Joey Loses His Insurance

Friends - SO6EQ5 - The One With Joey's Porsche

Friends - SO6E06 - The One On The Last Might

Friends - S06EQ7 - The One Where Phoebe Runs

Friends - SOEEQS - The One With Ross” Teeth

Friends - S06EQ9 - The One Where Ross Got High

Friends - SDEE10 - The One With The Routine (3 k.a. The One With The Rockir
Friends - SO6E11 - The One With The Apathecary Table

Friends - SO6E12 - The One With The Joke v

This only needs to be done once.




Episode thumbnails user guide for Existing users of TVrename:

Please delete all View.xml and series.jpg files before running TVrename.
To create a batch file to search and delete the above files, open Notepad and insert the following:

@echo off

del /s View.xml
del /s series.jpg
pause

Save the Notepad file as Delclean.bat
Place this in you Series folder and run it.....make sure it’s in the root of your Series folder only!!!

General | Files and Folders | Automatic BExport | Scan Options | Folder Deleting
Media Center | Search Folders | pToment £ NZB | Tree Coloring

HBMC () Frode () Eden (@) Both
[] Episode Thumbnails {tbn)
[ MFO files for shows and episodes
[T] Download XMBC Images fanart. poster, banner jpa)
py Tivo
[[] Meta files for episodes {bd)
[] Place Meta files in meta subfolder

MedeBer
[] Create series poster (series jpa)
¥ML files for shows and episodes
Shrink: large seres and episode images

General
Folderimage folderipal
() Banner () Poster (_) Fan At (8 Season Poster
Fanart Image fanart jpg)
Episode Thumbnails {jpg)

Cancel

Media Center tab

In TVrename click ‘Presets..” and select Mede8er.
The options will be as per above image.
As noted before, if Episode Thumbnails is selected the View.xml files will be created automatically.

File  Options | Teols | Help
B MyShows| 2 ForceRefesh Al |
\% = ¥ Background Download Now  Ctrl+B
U

Folder Menitor

|
aQ
Sh
o [ Actors Grid

Torrent Match

uTorrent Save To

Do a ‘Force Refresh All’ and Scan.
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